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Tools and Downloads

Overview

The latest ODPS service provides a new version of the client, compared with the old version, the new
client has the following improvements:

- You do not need to enter a command shell to execute a specified command. For example,
you can enter the client and run SQL comamnds and security commands directly in new
version. You do not need to enter SQL/Security shell at first and run corresponding
commands.

- The commands of new version is more closed to Hive commands. Most of comnands are
compatible with Hive.

Besides, you must note:

- This document is a part of User Manual for the client in ODPS. It describes how to use basic
functions of ODPS by using the command lines of the client.

- Do not perform the analysis operation based on the output format of the client. The output
format of the client is not ensured for forward compatibility. Clients in different versions are
different in their command formats and behaviors.

- ODPS client is a java program and can run only in the JRE environment. Therefore, it is
required to download and install JRE 1.6 version.

- If you need to learn about the use method of the client, refer to Quick Start.

Download and Installation

To downloa ODPS client, please click on Here.

Depress the downloaded file and you can find the following four folders:

bin/ conf/ lib/ plugins/
There is a file named odps_conf.iniin ‘conf’ . Edit this file and enter related information:
project_name=

access_id=<accessid>
access_key=<accesskey>
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end_point=http://xxxx

Note:

- Replace the access_id and access_key with the access_id and access_key applied from
www.aliyun.com.
- If you often use a project, you can add the name of this project behind of
“project_name=", which can avoid executing “use project_name;” command when
entering the client.
- end_point. The access URL differs for different regions. For more information, see Access
domains and data centers.

After the configuration file has been modified, run ‘odpscmd’ in bin directory. (If the OS is Linux,
run ‘/bin/odpscmd’ ; if the OS is Windows, run “./bin/odpscmd.bat’ .)Now you can run ODPS
commands:

odps@ test_project> whoami;

Name: ALIYUNStest_user@aliyun.com

End_Point: http://service.ap-southeast-1.maxcompute.aliyun.com/api
Project: test_project

Get Help

View the information about help. Commnd Format:

odps@ >./bin/odpscmd -h;

Oryou can type “h" or “help” in an interactive mode. (Case insensitive)

Starting Parameters

When starting the client, you can specify a series of parameters:

Usage: odpscmd [OPTION]...

where options include:

--help (-h)for help

--project=<prj_name> use project

--endpoint=<http://host:port> set endpoint

-u <user_name> -p <password> user name and password

-k <n> will skip begining queries and start from specified position

-r <n> set retry times

-f <"file_path;"> execute command in file

-e <"command;[command;]..."> execute command, include sql command
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-C will display job counters

Example: (take '-f° asan example)

- Prepare the local script file ‘script.txt’ . Suppose that the file is located in the disk D and
the content is shown as follows:

DROP TABLE IF EXISTS test_table_mj;
CREATE TABLE test_table_mj (id string, name string);
DROP TABLE test_table_mj;

- Running Command:

odpscmd\bin>odpscmd -f d:/script.txt;

- Display the execution result:

ID = 20150528122432906gux77io3

Log view:

http://webconsole.odps.aliyun-inc.com:8080/logview/?h=http://service-corp.odps.aliyun-
inc.com/api&p=o0dps_public_dev&i=2015052
8122432906gux77io38&token=RnlrSzJoL242YW43dFFlc1dmb1ZWZzFxQ1RFPSxPRFBTX09CTzoxMDcwMDI1NjI30DA
1NjISLDEOMzMOMjA2NzMsey)TdGFOZW1I
bnQiOIt71kFjdGlvbil6WyJvZHBzOUIYWQiXSwWiRWZmZWNOIjoiQWxsb3ciLCISZXNvdXJjZSI6WyJhY3M6b2RwczoqOnB
yb2plY3RzL29kcHNfcHVibGIjX2RId
i9pbnNOYW5jZXMVMjAXNTALMjgxMjI0MzI5MDZndXg3N2lvMyJdfVOsIIZIcnNpb24iOilxIn0=

OK

ID = 20150528122439318gcmkk6ul

Log view:

http://webconsole.odps.aliyun-inc.com:8080/logview/?h=http://service-corp.odps.aliyun-
inc.com/api&p=o0dps_public_dev&i=2015052
8122439318gcmkk6ul&token=dStORXdIVOMS5Y;ZET2I1MnJuUFkzZWDN1aWpzPSxPRFBTX09CTzoxMDcwMDI1NjI30
DALN;jISLDEOMzMOMjA20DAseyJTdGFOZW1|
bnQiOIt71kFjdGlvbil6WyJvZHBzOUIYWQiXSWiRWZmZWNOIjoiQWxsb3ciLCISZXNvdXJjZSI6WyJhY3M6b2RwczoqOnB
yb2plY3RzL29kcHNfcHVibGIjX2RId
i9pbnNOYW5jZXMVMjAXNTA1MjgxMjI0MzkzMThnY21razZ1MSJdfVOsIIZIcnNpb24i0ilxIn0=

OK

ID = 20150528122440389g98cmImf

Log view:

http://webconsole.odps.aliyun-inc.com:8080/logview/?h=http://service-corp.odps.aliyun-
inc.com/api&p=odps_public_dev&i=2015052
8122440389g98cmImf&token=NWIWLOEVQThxUXhzcTRERDc5NFg0b2IxZ3QwPSxPRFBTX09CTzoxMDcwMDILN;jI30
DALNjISLDEOMzMOMjA20DAsey)TdGFOZW1|
bnQiOIt71kFjdGlvbil6WyJvZHBzOUIYWQiXSWiRWZmZWNOIjoiQWxsb3ciLCISZXNvdXJjZSI6WyJhY3M6b2RwczoqOnB
yb2plY3RzL29kcHNfcHVibGIjX2RId
i9pbnNOYWS5jZXMvMjAXNTALMjgxMjIONDAzODINOThjbWxtZiJdfVOsIlZIcnNpb24iOilxIn0=

OK
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Interactive Mode

Directly running the client will enter the interactive mode.

[admin: ~]$odpscmd

Aliyun ODPS Command Line Tool

Version 1.0

@Copyright 2012 Alibaba Cloud Computing Co., Ltd. All rights reserved.
odps@ odps> INSERT OVERWRITE TABLE DUAL SELECT * FROM DUAL;

Input the command at the cursor position (take a semicolon as a statement end mark) and press
Enter to run.

Continuous Running

-When youuse '-e' or '-f optionto run command, you can specify the parameter ‘-k’
if there are multiple statements and you want to start running from a middle statement,
which indicates ignoring the previous statements and running from the specified position. If
the specified parameter <= 0, start running from the first statement.

- Each statement seperated by a semicolon is considered as a valid statement. The statements
which runs successfully or fail to run will be printed at running time.

- For example, there are three SQL statements in the file ‘/tmp/dual.sql’ :

drop table dual;
create table dual (dummy string);
insert overwrite table dual select count(*) from dual;

To ignore the first two statements:

odpscmd —k 3 —f dual.sql

Get Current Logon User

Command Format:

whoami;

Use Example:

odps@ hiveut>whoami;
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Name: odpstest@aliyun.com

ID: 1090142773636588

End_Point: http://10.249.215.1/odps_debugl
Project: lijunsecuritytest

Use: get the Alibaba Cloud account and endpoint configuration of current log user.

Exit
Command:

odps@ > quit;
org;

Eclipse Plugins

To facilitate the development work with Java SDK of MapReduce and UDF, MaxCompute provides
Eclipse Development Plug-in.This plug-in can simulate the running process of MapReduce and UDF
to provide local debugging methods for users and provide the function for generating a simple
template.

Note:

- To download this plug-in, click Here.

- Unlike the local running mode provided by MapReduce, Eclipse plug-in cannot
synchronize data with MaxCompute. The data used by users need to be manually
copied to the warehouse directory of Eclipse plugin.

After downloading the Eclipse plug-in, decompress the software package to find the following jar:
odps-eclipse-plugin-bundle-0.15.0.jar

Place the plug-in into the subdirectory ‘plugins’ in Eclipse installation directory. Start the Eclipse
plug-in, and click <Open Perspective> at the upper-right corner.
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Cluick Access

0= Qutline EZEW
An outline is not available.

e

(o))
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After clicking the button, the following dialog box is displayed:

%G\!E Repository Exploring
ﬁi Debug
o Git
ﬂJ Java {default)
E‘J Java Browsing

) Java Type Hierarchy
5 ODPS
== Plug-in Development
|._|i~| Resource

ED Team Synchronizing

i

Cancel 4

Select [ODPS] and click on OK. the MaxCompute icon will appear at the upper-right corner, indicating
that the plug-in takes effect.
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‘ T &JJava |4 ODPS

0= Qutline &2 = O

An outline is not available.

There are two methods to create MaxCompute project.

Method 1

Slect [File > New > Project > MaxCompute > MaxCompute Project] to create the project (in
the example, use 'ODPS’ as the peoject name):



MaxCompute

Tools and Downloads

o

=* ODPS Project
2% Java Project
4 Project...

@ Mapper

& Reducer

uee LIDF

B UDTF

H#¥ Package

& Class

& Interface

& Enum

(@ Annotation

&% Source Folder

% Folder
(% File

= Other...

& MapReduce Driver

151 Java Working Set

= Untitled Text File

3N

After creating MaxCompute project, the following dialog box will be popped up. Input

Project name, and select the path of MaxCompute console. (The console must be uploaded

at first.) At last, click <Finish>.
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4 L -

= O
J Create ODPS project
Project name: | odps
¥| Use default location
Location: d
ODPS Settings Config ODPS console installation path
Config ODPS censole installation path
Config ODPS console installation path
+ Use default ODPS console installation pathl i Docur print15/clifodp: _Browse...
) Specify ODPS console installation path Version: lower than 0.13.0
Warning: Version is too lower,suggest >=0.15.0
Version: lower than 0.13.0
Run Mode
Warning: Version is too lower,suggest >=0.15.0
+) Local
limit record count of downloaded
100 (0~10000)
7| Retain local job temp directory
@ o4
[ <terminateds UDAFExample |
54 Restore Defaults Apply

@ Cancel oK

Note:

- For the introduction of MaxCompute console, please refer to Console.

creating project is finished, the following directory structure will be viewed in the left

'Package Explorer’

10
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9 e O Qe G

¥ Package Explorer &3 St
v = odps
B src

F = JHRE System Library [Java SE T [1.7.0_71]]
F = Referenced Libraries
¥ #examples
L4 fE com.aliyun.odps.examples.mr
| iT_] Resource.java
> m WordCount.java
kL fE com.alivun.odps.examples. udf
| |I| UDAFExample.java
| m UDAFResource. java
| |I| UDFExample.java
| m UDFResource.java
» [J] UDTFExample. java
m UDTFResource.java
| EE com.aliyun.odps.examples. udf.test
[=temp
¥ (= warehouse
¥ (= example_project
P (= resources
¥ = __ tables_
P [(=-rs_out
k(= wc_ini
P (=wc_in2
F (= wc_out
|=| Readme

Method 2

Click <New> at the left-upper corner:

11

vl:lﬁ
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After the dialog box is popped up, select ‘ODPS Project’ and click on <Next>:

12
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Select a wizard <

Wizards:

(& Class

¥ Interface
4% Java Project
aﬁJava Project from Existing Ant Buildfile
gﬁ- Plug-in Project

F = General

b = CVS

F = Git

F (= Java

¥ (= 0DPS

@ Mapper

b ManBediuse Diel

&k ODPS Project

[EE uoTF

¥ = Plug-in Development
b = User Assistance

® Mext = Cancel

The subsequent operations are similar with Method 1.

The installation of MaxCompute Eclipse plug-in is completed. User can use this plug-in to
write MapReduce or UDF programs.

Note:

- For the function introduction of MapReduce in the plug-in, refer to
MapReduce Development Plug-in Introduction.

- For the UDF program example, please refer to UDF Development Plug-in
Introduction.

Run WordCount Example Quickly

Select WordCount example in MaxCompute project:

13
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(- $ 0 BE s e dooasTaxv
I Package Explorer 52 HE Y= 0 [ WordCountiava 2 =
¥ 5 odps package com.aliyun.odps.examples.mr;
e

» BAJRE Systom Library [Java SE 7 [1.7.0.71] mort java.io.T0Exception;]]

» ), Referenced Libraries

are
examples * BRBIRUR TMapReduce B S BEL
¥ [ com.aliyun.odps.examples.mr *
» |1 Resource java */
¥ [J] WoraGount java public class WordCount {

v (@ WordCount
» @ sumCombiner @
¥ & sumReducer
» @ TokenizerMapper
& mainiString[) : void
» [ com.aliyun.odps.examples. udf
» 3 com.aliyun.odps.examples. udf.test
(=temp =
» (> warehouse

public static class TokenizerMapper extends MapperBase {

Record word;
Record one;
Counter gCnt;

@0verride
public void setup(TaskContext context) throws I0Exception {
word = context.createMapOutputKeyRecord();
one = context.createMapOutputValueRecord();
one.set(new Object[] { 1L 1);
glnt = context.getCounter("MyCounters”, "global_counts
i3

=2 @0verride

- public void map(long recordNum, Record record, TaskContext context) throws I0Exception {

for (int i = @; i < record.getColumnCount(); i++) {

String[] words = record.get(i}.toString).split("\\s4");

for (String w : words.
word. set(new Object[] { w 1);
Counter cnt - context.getCounter("MyCounters”, "map_outputs");
cnt.increment(1);
gCnt.increment(1);
context.nrite(word, one);

H
i3
3

o e
* A combiner class that combines map output by sum them.
v

= public static class SumCombiner extends ReducerBase {
private Record count;

Right-click on  'WordCount.java’

12 Package Explorer 53 2% T=0 [ wordCountjava 2
¥ ¥ odps package com.aliyun.odps.exanples.mr;
(Bsre

b miJRE System Library [Java SE 7 [1.7.0_71]] @ inport java.io.I0Exception;|]
» i, Referenced Librarles
¥ (B exampies
¥ [ com.aliyun odps.examples.mr
» [ Resource j¢

o
* BRI TMopReduce BRI
.

Gount T = p:glic class WordCount {
'%E’;’;‘fm"(‘ 82:: with F3 | public static class TokenizerMapper extends MapperBase {
:gf:l:: Open Type Hierarchy Fa4 Record word;
Gy SowinRw e R
b [# com.aliyun.od| o e

» i com.aliyun.od)
(Etemp
> (=warehouse

] B0verride

public void setup(TaskContext context) throws IOException {
v word = context.createMapOutputKeyRecord();

one = context.createMapOutputValueRecord();

4 one.set(new Object[] { 1L 1);
>
>
>

gCnt - context.getCounter("MyCounters”, "global_counts");

and click Run As -> ODPS MapReduce, as follows:

Build Path
Source X#s
- | edverride
(e NP public void map(long recordNum, Record record, TaskContext context) throws IOException {
for (int i = @; i < record.getColumnCount(D; i++) {
i
2 Import... String[] words = record.get(i).toString().split(" \\s+");
e Export... for (String w : words) {
word.set(new Object[] { w });
References > Counter cnt - context.getCounter("MyCounters”, "map_outputs');
Declarations > ent.increment(1);
glnt.increment(1);
& Refresh 5 , context.write(nord, one);
Assign Working Sets...
Debug As >
Java Application X#xJ
;asm With : 2 ODPS Mapreduce output by sum them.
COIpare s 3 ODPS UDF|UDTF|UDAF
Replace With > |s ReducerBase {
Restore from Local History... Run Configurations...
Branartios e |

After the dialog box is popped up, select ‘example_project’

14

and click Finish:
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ODPS Mapreduce Run Configuration

Class

com.aliyun.odps.examples.mr.WordCount

Run Mode

| Local

Select ODPS Project

example_project

Add
Edit

Remove

Resources

Program Arguments

@ Cancel Finish

After running is successful, the following result will be displayed:

15
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& Console % % |G bE[EE)| 2 B-T3- = O
<terminated> WordCount [ODPS Mapreduce] /Library/Java/JavaVirtualMachi 1.7.0_71 jdk/Contents/Home/bin/java (201551 H27H F4F3:42:38)

&8 Reload warehouse table:wc_out

Summary:

Inputs:

example_project.wc_inl,example_project .wc_in2/pl=2/p2=1
Outputs:
example_project.wc_out

M1_example_project_LOT_8_0_8_jobd
Worker Count: 2
Input Records:
input: 7 (min: 3, max: 4, avg: 3)
Output Records:
R2_1: 17 (min: 8, max: 9, avg: 8)
R2_1_example_project_LOT_2_8_8_job@
Worker Count: 1
Input Records:
input: § (min: 5, max: 5, avg: 5)
Output Records:
R2_1FS_8: 5 (min: 5, max: 5, avg: 5)
counters: 10
map-reduce framework: 7
combine_input_groups=5
e_output_records=5
put_bytes-87
nput_records=7
map_output_records=17
reduce_output_[example_project.wc_out]_bytes=37
reduce_output_[example_project .wc_out]_records=5
user defined counters: 3
mycounters
global _counts-22
map_outputs-17
reduce_outputs=5

oK
Instanceld: mr_20150127074239_358_27772

Run Uer-defined MapReduce Program

Right-click ‘src’ directory. Select New -> Mapper:

16
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% ODPS Project
2% Java Project
4 Project...

& MapReduce Driver

& Reducer
ue UDF

B UDTF

# Package
& Class

& Interface
& Enum

@ Annotation

&% Source Folder

14 Java Working Set
% Folder

[ File

Z Untitled Text File

= Other...

3N

5E 7 [1.7.0_71]]

les.mr

wer

woid

les. udf

les. udf.test

After selecting ‘Mapper’ and the following dialog box is displayed. Input the name of

Mapper class and click Finish:

17
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Mapper

Create a new Mapper implementation.

Source folder: | odps/src Browse...
Package: odps Browse...
Mame: UserMapper

Superclass: com.aliyun.odps mapred.MapperBase Browse...
Interfaces: Add...

@ Cancel Finish

Now you can find a file ‘UserMapper.java' is generated in the directory ‘src’ in
‘Package Explorer’ . The content of this file is a template of Mapper class:

package odps;

import java.io.IOException;

import com.aliyun.odps.data.Record;

import com.aliyun.odps.mapred.MapperBase;

public class UserMapper extends MapperBase {

@Override

public void setup(TaskContext context) throws IOException {

}

@Override

public void map(long recordNum, Record record, TaskContext context)
throws IOException {

1

@Override

public void cleanup(TaskContext context) throws IOException {
}

}

In the template, the configured package name defaults to ‘odps’ . You can modify it
according to your actual requirement. Write the template contents as follows:

18
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package odps;

import java.io.IOException;

import com.aliyun.odps.counter.Counter;

import com.aliyun.odps.data.Record;

import com.aliyun.odps.mapred.MapperBase;

public class UserMapper extends MapperBase {

Record word;

Record one;

Counter gCnt;

@Override

public void setup(TaskContext context) throws IOException {
word = context.createMapOutputKeyRecord();

one = context.createMapOutputValueRecord();

one.set(new Object[] { 1L });

gCnt = context.getCounter("MyCounters", "global_counts");
}

@Override

public void map(long recordNum, Record record, TaskContext context)
throws IOException {

for (inti = 0; i < record.getColumnCount(); i++) {

String[] words = record.get(i).toString().split("\\s+");

for (String w : words) {

word.set(new Object[] { w });

Counter cnt = context.getCounter("MyCounters", "map_outputs");
cnt.increment(l);

gCnt.increment(1);

context.write(word, one);

}

}

}

@Override

public void cleanup(TaskContext context) throws IOException {
}

}

] I

In the same method, right-click ‘src’ directory and select New -> Reduce:

19
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Reducer

Create a new Reducer implementation.

Source folder: | odps/src Browse...
Package: odps Browse...
Mame: UserReduce

Superclass: com.aliyun.odps mapred.ReducerBase Browse...
Interfaces: Add...

@ Cancel Finish

Input the name of Reduce class. (In this example, use ‘UserReduce’ as the class name):

In 'Package Explorer’ , a file name ‘UseReduce.java’ is generated in the directory
‘src’ . This file content is a template of Reduce class. Edit the template:

package odps;

import java.io.IOException;

import java.util Iterator;

import com.aliyun.odps.counter.Counter;

import com.aliyun.odps.data.Record;

import com.aliyun.odps.mapred.ReducerBase;

public class UserReduce extends ReducerBase {

private Record result;

Counter gCnt;

@Override

public void setup(TaskContext context) throws IOException {
result = context.createOutputRecord();

gCnt = context.getCounter("MyCounters", "global_counts");
}

@Override

public void reduce(Record key, Iterator<Record> values, TaskContext context)
throws IOException {

long count = 0;

while (values.hasNext()) {

Record val = values.next();

20
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count += (Long) val.get(0);

}

result.set(0, key.get(0));

result.set(1, count);

Counter cnt = context.getCounter("MyCounters", "reduce_outputs");
cnt.increment(l);

gCnt.increment(1);

context.write(result);

}

@Override

public void cleanup(TaskContext context) throws IOException {
}

}

Create 'main’ function: right-click ‘src’ and select New -> MapReduce Driver. Enter
Driver Name (in this example, use ‘UserDriver’ as the name), Mapper and Recduce (in

this example use ‘UserMapper’ and ‘UserReduce’ as corresponding name) and click
Finish;. The file 'MyDriver.java file' is also displayed in ‘src’ directory:

MapReduce Driver

Create a new MapReduce driver.

Source folder: odps/src Browse...
Package: odps Browse...
Mame: UserDriver

Superclass: java.lang.Object Browse...
Interfaces: Add...
Mapper: UserMapper Browse...
Reducer: UserReduce Browse...

@ Cancel Finish

Edit the contents of driver:

21
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package odps;

import com.aliyun.odps.OdpsException;

import com.aliyun.odps.data.Tablelnfo;

import com.aliyun.odps.examples.mr.WordCount.SumCombiner;
import com.aliyun.odps.examples.mr.WordCount.SumReducer;
import com.aliyun.odps.examples.mr.WordCount.TokenizerMapper;
import com.aliyun.odps.mapred.JobClient;

import com.aliyun.odps.mapred.RunningJob;

import com.aliyun.odps.mapred.conf.JobConf;

import com.aliyun.odps.mapred.utils.InputUtils;

import com.aliyun.odps.mapred.utils.OutputUtils;

import com.aliyun.odps.mapred.utils.SchemaUtils;

public class UserDriver {

public static void main(String[] args) throws OdpsException {
JobConf job = new JobConf();
job.setMapperClass(TokenizerMapper.class);
job.setCombinerClass(SumCombiner.class);
job.setReducerClass(SumReducer.class);

job.setMapOutputKeySchema(SchemaUtils.fromString("word:string"));
job.setMapOutputValueSchema(SchemaUtils.fromString("count:bigint"));

InputUtils.addTable(

Tablelnfo.builder().tableName("wc_in1").cols(new String[] { "col2", "col3" }).build(), job);

InputUtils.addTable(TableInfo.builder().tableName("wc_in2").partSpec("pl=2/p2=1").build(), job);

OutputUtils.addTable(TableInfo.builder().tableName("wc_out").build(), job);

RunningJob rj = JobClient.runJob(job);
rj.waitForCompletion();

}

}

Run MapReduce program. Right-click ‘UserDriver.java’
MapReduce to appear the following dialog box:

22

and select Run As -> ODPS
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ODPS Mapreduce Run Configuration

Class

odps. UserDriver

Run Mode

| Local

Select ODPS Project

example_project

Add
Edit
Remove

Resources

Program Arguments

@ Cancel Finish

Select ‘example_project’ as the MaxCompute Project and click Finish to run MapReduce
program on the local:

23
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& Gonsole 3 X% GREEE tE-r9-= 0
UserDriver [ODPS. ILibraryhJava, .7.0_71.jdk/Contents/Home/binjava (2015915327 H T44:22:42)

Summary

Tnputs:

example_project.we_inl,example_project.we_in2/pl-2/p2-1
Outputs:
example_project.wc_out

M1_example_project_LOT_0_0_0_job@
Worker Count: 2
Input Records:
input: 7 (min: 3, max: 4, avg: 3)
Output Records
R2_1: 17 (min: 8, max: 9, avg: 8)
R2_1_example_project_LOT_0_8_0_jobd
Worker Count: 1
Input Records:
input: 5 (min: 5, max: 5, avg: 5)
Output Records
R2_1FS_9: § (min: 5, max: 5, avg: 5)
counters: 10
map-reduce framework: 7
combine_input_groups=5

map_input_records=7
map_output_records=17
reduce_output_[example_project.wc_out]_bytes=37
reduce_output_[example_project.wc_out]_records=5
user defined counters: 3

mycounters
global_counts=22
map_outputs-17
reduce_outputs=5

oK
Instanceld: mr_20150127082243_604_27864

If the information is output as mentioned above, it indicates that local operation runs
successfully. The output result is saved in the directory ‘warehouse’ . Refresh
MaxCompute project:

s O G Gl ] T e et e B o » /s T & x v
|
C = |
1% Package Explorer 53 BS O[5} wordCount [J] UserReduce.java (3] UserDri R_000000 | EEER b
v B oaps 42,4
< e A3,4
= three1,3
» [1) userDriver,ava ::::s;
> [1] UserMapperjava !
¥ [3] UserReduce.java

b \,JRE System Library [Java SE 7 [1.7.0_71]]
» ), Referenced Libraries
¥ Bexamples
¥ [ com.aliyun.odps.examples.mr
» ] Resource java
¥ [1] werdCount.java
v @ wordCount
» @ sumGombiner
» @ sumReducer
» @ TokenizerMapper
@ main(String[) : veid
b f# com.aliyun.odps.examples.udf
b 3 com.aliyun.odps.examples.udf.test
(Etemp
¥ (Swarehouse
¥ (=-example_project
¥ (= __resources.
P = table_resourcel
P (& table_rasource2
file_resource.txt
¥ (= _tables,
» = rs_out
» G we_in
» (= we_in2
¥ (= we_out
[5 __scnema
BGEEiesy E Console 8 x
= Reaame

<terminated: UserDriver [ODPS Mapreduce] /Library/Jar .7.0_71.jak/Gontents/Home/bin/java (201551 527 H FF4:22:42)
TS KEL0Og Warenouse tapieinc_out

Summary:
Inputs
example_project.wc_inl,example_project.wc_in2/pl=2/p2=1

Witable Insert B

‘wc_out’ is the output directory and 'R_000000" is result file. Through local
debugging, the result is confrmed to be correct and you can package MapReduce
program through Eclipse export function. After it is packaged, upload the jar package to
MaxCompute. About how to execute MapReduce in distributed environment, refer to
Quick Start.

After the local debugging passed, user can package the codes into jar package through
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Eclipse Export function, provided for subsequent distributed environment. In this example,

we nominate the package
Export:

v = odps

b =, JRE System Library [Java SE 7 [
F =i, Referenced Libraries
¥ i # examples
v J:E com.aliyun.odps.examples.mi
L 4 m Resource.java
¥ m WordCount.java
v (& WordCount
L g @ SumCombiner
L4 Gﬁ SumReducer
> Gﬁ TokenizerMapper
03 main(String[]) : void
L g ﬂ} com.aliyun.odps.examples.ud
L g EE com.aliyun.odps.examples.ud
[=temp
¥ = warehouse
¥ [=-example_project
¥ [ resources__
b =table resourcel
b [=table resource?
file_resource.txt
¥ = _tables__
P [(=ers_out
P =we_int
P = we_in?
¥ = weo_out
|=| __schema__
|=| R_000000
|= Readme

Select ‘'Jar File’ as an export mode:

‘mr-examples.jar’ . Select the directory ‘src’ and click
AZ.4

New [
Go Into
Open in New Window
Open Type Hierarchy F4
Show In NHEW e
=/ Copy 8C
&= Copy Qualified Name
(% Paste gg\/
* Delete =
Build Path S
Source S »
Refactor BT [ 2
g2 Import...

" Refresh F5
Assign Working Sets...

Debug As

Run As

Team

Compare With

Restore from Local History...
= Import from Repository...

y¥yYyY Yy

Properties 28l
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(o e, lowc
| | select A

il | Export resources into a JAR file on the local file system. H

Select an export destination:

|type filter text |

[ = General
[ = Install

|71 JAR file|
[ Runnable JAR file
= Plug-in Development
= Run/Debug

= Team

v v v

@ | = Back || MNext = I | Finish | [ Cancel ]

You just need to export the package in ‘src’ . Specify the name of Jar File to be ‘mr-
examples. jar’
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£ JAR Export

S W

JAR File Specification

(1) The export destination will be relative to your workspace.

4 [@*% oDPS
4 [#] g src
[+ [# com.aliyun.odps.mapred.

I [7] & examples
[ &= mr_local_jobs
B [0 = wa

rehouse

4|

1

;

[l «classpath
[ B project

[ Export Java source files and resources

Export generated class files and resources

[ Export all cutput folders for checked projects

[7] Export refactorings for checked projects. Select refactorings...

AR fle |

ptions:

Compress the contents of the JAR file

Click Next to export the jar file successfully.

- Browse...

If you want to simulate new Project creation in the local, you can create a subdirectory (has
same level with example_project) in the directory ‘warehourse’ . The directory hierarchy

structure is shown as follows:

<warehouse>

|___example_project(Project Dirctory)
 <_tables_ >
table_namel(non-partition table)
____data(File)

<__resourc

<_ref_>

__<_schema__> (File)

| <_schema__> (file)

es_ >

I
I
I
I
I
|__table_name2(Partition Table)
I
I
|
|

table_resource_name (table resource)

partition_name=partition_value(partition directory)
___data(file)
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|___file_resource_name ( file resource )

'_schema_ ' Example:

Non-partiton table:

project=project_name

table=table_name
columns=col1:BIGINT,col2:DOUBLE,col3:BOOLEAN,col4:DATETIME,col5:STRING
Partition table:

project=project_name

table=table_name
columns=col1:BIGINT,col2:DOUBLE,col3:BOOLEAN,col4:DATETIME,col5:STRING
partitions=col1:BIGINT,col2:DOUBLE,col3:BOOLEAN,col4:DATETIME,col5:STRING

Note:
At present, the following five data formats are supported: bigint,double,boolean,datetime,string, which
correspond to the data types in java: -long,double,boolean,java.util.Date java.lang.String.

‘data’ Example:

1,1.1,true,2015-06-04 11:22:42 896,hello world

ANANANANAN

Note:

The time format is accurate to the millisecond level and all types are represented NULL by "\N'.

Note:

- If mapReduce program runs in the local, the default is to search
corresponding tables or resources from the directory ‘warehouse’ . If the
tables or resources are not existent, corresponding data will be downloaded
from the server and saved in  ‘warehouse’ . Then run MapReduce in the
local.

- After running MapReduce is finished, please refresh the directoty

‘warehouse’ to view generated result.

Local Debug UDF Program

This section describes how to develop UDF with the Eclipse plug-in and how to run UDF on local. The
preparation and implement process is similar to UDF. You can refer to the example of UDF.

MaxCompute Eclipse plug-in provides two methods to run UDF: Menu Bar and quickly running by
rigit-clicking it.

Run UDF through Menu Bar
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Select Run > Run Configurations... from the menu bar and the following dialog box
appears:

Create fi ti

- o

& Run Configurations

0E X | = :"-=":> T MName: Resource
type filter text ® Main._0ODPS Conﬁg} )= Arguments] = JRE] = Classpath] = Environmenq = Common]
[T Java Application - Project:
[T ccc A
1 fileupload odps project
[T helloworldapp Main class:
1] maggieTest -
o test com.aliyun.odps.examples.mr.Resource
Ju JUnit [[]Include system libraries when searching for a main class
m2 Maven Build [[]Include inherited mains when searching for a main class i
i ODPS Mapreduce [] Stop in main
i Mydriver = i
ik Resource
b UserDriver
& WordCount
uf ODPS UDF|UDTFUDAF
ure New_configuration
u¥ UDFExample
u UserUDF
Juj Task Context Test
] m r ;
Filter matched 19 of 19 items Apply Revert

©) [ R ][ des

You can create a new Run Configuration. Select the UDF class and type to be executed,
select MaxCompute Project and enter the information of input table. For example:
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Run Configurations

Create, manage, and run configurations

©

OB %x B & Name: |udf
| B\ JRE| % Classpath| B§ Envimnmentﬁ =] Q_nmmo-n-f
f Apache Tomcat Pm__jECt: -
@ Eclipse Application |odps_example ;
& Eclipse Data Tools UDF|UDTF|UDAF class:
B Generic server | com.aliyun.odps.examples.udf.UDFExample | Search... I
f Generic server(External L (s —
f HTTP Preview Class Type
f J2EE Preview @® UDF () UDTF () UDAF
Java Applet Select ODPS project
®:F Iava Applicatian example_project | Add
Ju Junit
Jt Junit Plug-n Test _ Edit |
m2 Maven Build |Remove|
¥ & ODPS Mapreduce =
& wordcount e st
& oops UDFlUDTFUDAF | || Tebler  |wc in2
4 udf Partitions: |p2=1,p1=2 | ie: p1=1,p2=1 (default all partitions)
# 0sGi Framework — — =
Juy Task Context Test Columns: |colc,cola,colb | ierct,e2,c3 (default all columns)
) XSL

Filter matched 20 of 167 items |

@ Close l Run :J

In the configuration mentioned above, “Table” indicates the input table of UDF.
“Partitions” indicates the partitions from which the data is read, seperated by

commas. “Columns” indicates the columns, which will be considered as the parameters of

UDF to be introduced. The columns are seperated by commas.

Click Run to execute the program and the running result is displayed in the console:

Bl console 55 < ® % E &F (&

<terminated> udf [ODPS UDF|UDTF|UDAF] /home/shihai/lib/java/bin/java (Dec 12, 2014 7:32:23 PM)
55525:three3, threel, three2
ss552s5:three3, threel, three2
55525:three3, threel, three2

Running Quickly by Right-clicking it

Select a udf java file (such as: UDFExample.java) and rigit click the mouse. Then select Run
As > Run UDF|UDAF|UDTF:
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[% Package Explorer 52 BE Y=0 [J] UDFExample.java 52
vi‘godps package com.aliyun.odps.examples.udf;
[ src 3 )
» =4 JRE System Library [Java SE 7 [1.7.0_71]] import com.aliyun.odps.udf.UDF;

» =, Referenced Libraries
¥ (Bexamples
> B}com.aliyun.odps.axamplas.mr

public class UDFExample extends UDF {

1 T
vﬁ}com.aliyun.odps.axamplas.ud New P t: example_project
> m UDAFExample.java we_inl
b [J] UDAFResource.java Open F3 s: coll,col2
Open With >
b .J| UDFR: 5] i
D esourcel_ava Opan Twa Hleramny F4 ring evaluate(String a, String b)
» [J] UDTFExample.java Show In CEW P oo 4 g 4 " 4 b
» [J] UDTFResource.java ! !
» 3 com.aliyun.odps.examples.ud B Cepy 2C
[=-temp = O :
0 ualified Name
P =-warehouse Efl Py Q t: example_project
(5 Paste BV cint
# Delete X s: coll,col?,cold,cold
Build Path > Luate(Stri String b
= ring evaluate(String a, ring b,
Source \_&ES P ohccce?s:" a4 "," 4+ b4 ", 40
Refactor HT >
23 Import...
uﬁExport... E: e*ample_project
wc_in2
References p [ons: p2=l,pl-=2
’ s: calc,calb,cala
Declarations >

ring evaluate(String a, String b,
«" Refresh F§ Msss2s:" 4+ a + "," + b+ "," + ¢

Assign Working Sets...

Debug As >

Team > ) . |

Compare With > Run Configurations...

Replace With >

Restore from Local History... Lproject.wc_inl,example_project.wc
com.al iyun.odps.sxamples.ud[.UDFExampla] Proper‘ties 3l |

The configuration information is shown as follows:
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QDPS UDF|UDTF|UDAF Run Configuration

Class

com.aliyun.odps.examples.udf. UDFExample

Select ODPS Project

example_project

Add
Edit
Remove
Input Table
Table: wc_in2
Partitions: |p2=1,p1=2 ie: p1=1,p2=1 (default all partitions)
Columns: | colc,colb.cola ie: ¢1,c2,c3 (default all columns)
@:I Cancel Finish

In the configuration mentioned above, “Table” indicates the input table of UDF.
“Partitions” indicates the partitions from which the data is read, seperated by

commas. “Columns” indicates the columns, which will be considered as the parameters of

UDF to be introduced. The columns are seperated by commas.

Click on Finish to run UDF and get the output result.

Running Customized UDF Program

Right click the mouse on a project and select New >UDF (or select the menu bar File > New > UDF).

]

Enter the UDF class name and click “Finish” . Generate a Java file in corresponding ‘src¢’ directory
with the same name as this UDF class. Edit this java file:

package odps;

import com.aliyun.odps.udf.UDF;
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public class UserUDF extends UDF {

/**

* project: example_project

* table: wc_inl

* columns: coll,col2

*/

public String evaluate(String a, String b) {
return "ss2s:" +a + "," + b;

}

Right click this java file (such as UserUDF java) and select Run As -> ODPS UDF|UDTF|UDAF:

[% Package Explorer 22 = Y= 8 UDFExample.java [J] UserUDFjava &2
v 4% odps package odps;
¥ Harc
v &4 odps import com.aliyun.odps.udf.UDF;
'
ew >
» =} JRE System Library [Java SE 7 [1.7.0_71]] 7 AT R d
» Ei Referenced Libraries Open Fa
v j;?exam ples Open With p [example_project
bﬁ}com.aliyun.odps.axﬁmplas.mr n Linl
¥ i com.aliyun.odps.examples.udf g::en -Irypa Hie rarcth 2w :_4 coll,col2
[ 3 m UDAFExample.java oy
bm UDAFResource.java =0 . .
= Co #®C
[ 3 m UDFExample.java L?T‘ Py N g::ra:u:t:(ft:l:gbc-u, Stginglbii
bm UDFResource.java =] COD}I' Qualified Name : . !
» [J] UDTFExample java [ Paste BV
» [J] UDTFResource java 3 Delete =
[ 3 B} com.allyun.odps.examples.udf.test
= temp Build Path >
¥ (= warehouse Source NS »
Refactor T >
g2 Import...
e Export...
References 2
Declarations » 5 UDF|UDTF|UDAF] /Library/Java/JavaVirtual
< Refresh Fs
Assign Working Sets...
Debug As > |
Run As » [5 1 ODPS UDF|UDTF|UDAF
Team >
Gompare With » Run Configurations...
Replace With >

Restore from Local History...

Properties |

Configure the following dialog box:
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QODPS UDF|UDTF|UDAF Run Configuration

Class

odps.UserUDF

Select ODPS Project

example_project

Add
Edit
Remove
Input Table
Table: we_int
Partitions: ie: p1=1,p2=1 (default all partitions)
Columns: | coll.col? ie: ¢1,c2,c3 (default all columns)

@

Click finish to get the result:

ss2s:A1,A2
ss2s:A1,A2
ss2s:A1,A2
ss2s:A1,A2

Only the operation instance of UDF is described in this section, and the way of UDTF operating is
quite similar with the UDF, therefore, no special descriptions about this situation.

After creating a MaxCompute project, user can write Graph program and complete the local
debugging accoring the following steps.In this example, we select “PageRank.java” provided by the
plug-in to complete the debugging.

Select PageRank. java in examples:
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%G Y= 8  [1 PageRankjava 51
package com.aliyun.odps.examples.graph;

@import java.io.IOException;[]

P =\ JRE System Library [Java SE 7 [1.7.0.71]]

» &) Referencer
B examples
¥ £ com.ali

» [ com.ali
» i com.ali

¥ £ com.aliyun.odps.examples udf test

(temp

5
¥ [J] PageRank java

>[I ssSPjava

d Libraries.

iyun.odps.examples graph

lyun.odps.examples.mr
lyun.odps.examples.udt

» (= warehouse

Right click the mouse and select Debug As -> ODPS MapReduce|Graph:

% Eclipse Flle Edit Souce Refactor Navigate Seach Project Run Window Help B0 b T Bi BTF551

e
* Set program arguments:
* pagerank_in pagerank_out
x

*
public class PageRank {

= public static class PageRankVertex extends
Vertex<Text, DoubleWritable, NullWritable, DoubleWritables {

5 @0verride
a public void compute(Computelontext<Text, Doubleliritable, Nulliritable, Doubleritables context,
Iterable<Doublefiritables messages) throws I0Exception {
if (context.getSuperstep() == 8) {
setValue(nen Doubleliritable(1.0 / context.getTotalNumVertices()));
} else if (context.getSuperstep() >= 1) {
double sum = 8;
for (Doubleliritable msg : messages) {
sum 4= msg.get();

Doublefiritable vertexValue =
new Doubleliritable((8.15F / context.getTotalNumVertices(3) + 8.85F * sum);
setValue(vertexValue);

if (hasEdges()) {
context.sendMessageToNeighbors(this, new DoubleritableCgetValue().get()
/ getEdges().size(D));

) FFEEER 2015-04-14 F45.51.22

% Package Explorer 53

Java - - Eclipse - /L

CiER==Io

b B JRE System Library [Java SE 7 [1.7.0.71]]
> B Reforanced Librarios.

¥ [Bexamples

¥ i com alyun ocs.oxangies araoh
» 3] Kem New

> [2] SssE
» g com.aiy
» g com.ally
» i com.ally
Etomp

b Ewarchouse

——

Open

Open With

Open Type Hierarchy
In X

Show BW

[ Copy

{2 Copy Qualified Name:
T Paste

X Delete

Build Path

Source %S
Refactor X®T

223 Import...
123 Export...

References
Declarations

& Refresh

Team
Compare With
Replace With

Restore from Local History...

Properties

) PageRankjava 53 = 0 | g outine 5T
package com.aliyun.odps.examples. graph; N =
N iy e PR e
@ import java.ic. I0Exception;[ B comayun.odps.sxamples. graph
v, P
e » ©° PagoRankvertex

+ Set progran arguments » @ PagoRankVortexRoador

* pogerank_in pagerank_out

: & © printUsageq - voi

> w @ * main(Stringl) : void
= public class PageRank {
S public static class PageRankertex extends
" Vertex<Text, DoubleMeitable, NullNritable, CoubleNritables {
>
e #0verride
ue - public void compute(ComputeContext<Text, DoubleWiritable, NullWritable, DoubleNritables context,
Iterable<DoubleNritable- messages) throws IOException
1F Ccontext . getSuperstep() — @) (
=V setValue(nen Doublelri tableCi @ / context.getTotalNunVertices()));
® } else if Ceontext.getSuperstep() = 1) {
double sum = 0;
> for (BoubleMritable msg : messages) {
sum om m3g.90t 05
»
> DoubleRritable vertexValue =
Bou 156 / context cesO) + 0.85F * sumd;
setValue(vertexValue);
if thastdges 0y
context. sendMessageToeighbors(this, new Doubleritable(getValue().get()
» / getEdges().size()));
» . }
[ ;
? Problems @ Javadoc ation & Console 52 X% &EEE e

07 FE4:17:03)

» S ODRS UDFUDTT h.Tocol sovetutputs

> | Debug Configurations.

The dialog box appears and configure it as follows:
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QODPS Mapreduce|Graph Run Configuration

Class

com.aliyun.odps.examples.graph.PageRank

Run Mode

* | Local Remote

Select ODPS Project

muata_otat

example_project Add

Edit

Remove

Resources

Program Arguments

pagerank_in pagerank_out

@ Cancel Finish

View the running result:

Problems @ Javadoc |2, Declaration E) Console 52 X% GEEEE #E-r9-= D0

PageRank [ODPS Library/J: i 1.7.0_71.dk/C i (2015545140 F45:55:53)

: Finished to write table scheme : example_project.pagerank_out--»/Users/alibaba/Documents/eclipse/workspace/test/temp/graph_20150414095554_448_810
A 14, 2015 5:55:55 4 com.aliyun.odps.graph.local.master.Master init
£: worker num :1

vertex edgs size: 2

1
3
vertex edgs size: 2

2
3

vertex edgs size: 2

1
2
vertex edgs size: 2
User defined counters: 4
com.aliyun.odps.graph. lacal . COUNTER

TASK_INPUT_BYTE-24

TASK_INPUT_RECORD=4

TASK_QUTPUT_BYTE-84

TASK_OUTPUT_RECORD-4
PUF 14, 2015 5:55:55 com.aliyun.odps.graph. local .Local GraphlobRunner moveOutputs
{5 Reload warehouse table:pagerank_out
graph task finish
Job Finished in 1.842 seconds

36



MaxCompute Tools and Downloads

You can view the computing result on the local:

3 o A G e 8 G e E ) e e

% Package Explorer 22 =% Y=a attempt_graph_20150106031645_507_4332_000000_0 52

¥ i test
EBerc
P EJRE System Library [Java SE 7 [1.7.0.71]]
¥ i Referenced Libraries
¥ (#examples
¥ £ com.aliyun.odps.examples.graph
b [J] Kmeans.java
¥ [J] PageRank java
» [J] ssSPjava
¥ [ com.aliyun.odps.examples.mr
¥ [ com.aliyun.odps.examples.udf
» £ com.aliyun.odps.examples.udf.test

Problems @ Javadoc Declaration & Console 58

= temp i PageRank [ODPS /Uibrary/JavalJava i 1.7.0_71dk/Contents/Home/bin/ja
:
¥ = example_project L
b (= _resources r
V(= _tables >
» = kmeans_in 4
» (= kmeans_out v
¥ (= pagerank_in 2
b (2= pagerank_out ;
v
4
2
3
v
3
1

#: Finished to write table scheme : example_project.pagerank_out--»/Users/alibaba/Documents/
U/ 14, 2015 5:55:55 T4 com.aliyun.odps.graph.local .master Master init
2: worker num :1

ertex edgs size: 2

(= rs_out

»[Zssspin
¥ (= sssp_out

chama,

ertex edgs size: 2

| |= attempt_graph_20150106031645_507_43{
’BWC inT
’BWC in2
> (= we_out 2 . | . )
. vertex edgs size:
= Reacme User defined counters: 4
com.aliyun.odps. graph. local . COUNTER
TASK_INPUT_BYTE-24
TASK_INPUT_RECORD=4
TASK_OUTPUT_BYTE-84
TASK_OUTPUT_RECORD=4
A 14, 2015 5:55:55 T com.aliyun.odps.graph.local.localGraphlobRunner moveOutputs
f&8: Reload warehouse table:pagerank_out
araph task Finish
Job Finished in 1.842 seconds

ertex edgs size: 2

| writasle | Insert

Afther the debugging passed, you can package the program and upload it to MaxCompute as a Jar
resource. Then submit Graph job.

Note:

- For the package process, refer to MapReduce Eclipse Plug-in Introduction.

- For the structure introduction of local result, refer to MapReduce Eclipse Plug-in
Introduction.

- For the detaied introcution of uploading Jar resource, refer to ‘Add Resource’ in
Basic Introduction.

- For submitting the Graph job, refer to Graph Function.

- SDK Downloads: maven user can search “odps-sdk” from Maven library get MaxCompute
Java SDK.

- MaxCompute console: click here.

- Eclipse plugin: click here.

- Intelij plugin: click here , Studio : click here.
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